
 

Add-On Products 
Roms Hule 8 – 7100 Vejle – Denmark 
Phone: +45 7944 7000 Fax: +45 7944 7001 
 
Mail: info@add-on.com 
Internet: www.add-on.com 
 
No parts of this publication may be reproduced in any form or by any means or used to make any derivative 
such as translation, transformation, or adaptation without the permission from Add-On Products. 
 

 
 
 
 
 
 
 
 
 
 
 

 
 

 

User Guide 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Version 2.16  

http://www.ms-add-on.com/


 

CHAPTER 1 

Table of contents 2 
 

 

Table of contents 

Table of contents ......................................................................................................................................... 2 

CHAPTER 1. 3 
Introduction .................................................................................................................................................. 3 

Ariadne Functionality Overview ............................................................................................................. 7 

CHAPTER 2. 8 
Using Ariadne .............................................................................................................................................. 8 

Getting Started...................................................................................................................................... 8 
User Interface Items .............................................................................................................................. 9 
Events tab........................................................................................................................................... 13 
Guests tab .......................................................................................................................................... 23 
Information tab .................................................................................................................................... 27 
Message tab ....................................................................................................................................... 31 
Rooms tab .......................................................................................................................................... 35 
Special tab .......................................................................................................................................... 37 
Background tab................................................................................................................................... 40 
Signs tab ............................................................................................................................................ 45 
Media tab ............................................................................................................................................ 48 
Preview............................................................................................................................................... 61 
Recurring (End By, never ending) ....................................................................................................... 63 

CHAPTER 3. 65 
Trouble Shooting ....................................................................................................................................... 65 

 
 
  



 

CHAPTER 1 

Introduction 3 
 

 

CHAPTER 1.  

Introduction 

This document provides a detailed guide to use the Ariadne web application.  
The document consists of the following chapters:   

 Introduction  

 Using Ariadne 

 Trouble Shooting 

The Introduction overviews the Ariadne web application main functionalities. 

In this chapter:  

 Definitions, Acronyms and Abbreviations  

 Ariadne functionality overview   

The Using Ariadne chapter elaborates the Ariadne functionalities and how to use them. 
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Definitions, Acronyms and Abbreviations 

Term Definition 

IUI Intuitive User Interface 

Event 

Even is an overall term for a real life incident which should be displayed at 
Signs and thus are to be created in the Ariadne system.  

An Event can for example be a conference at a hotel, a guest visiting a 
company, an announcement or a media advertisement. The common 
denominator for an Event is that there is a start and end time and position for 
the placement at the Sign(s). 

External booking 
event 

External booking event is event which is book by another Facility 
management system or Event management system and imported by Ariadne 
External booking service. 

Sub-event 
A sub-event has a parent event relation with the main event. A sub event 
takes place at the same date and has the time range limited by the main 
event’s time. 

Event Types 
Events are of different types which are Event, Guest, Information, Message, 
Background and Special. 

Sign 

A physical stand with a built in monitor and client system to interpret the 
instructions from the server part of the system and visually display the output 
for the Viewers. 

There are two sign types which are PNG signs and multimedia signs. PNG 
signs or e-sign-NG can only display image while Multimedia signs or m-sign 
can display other media files such as flash, video, animation, RSS or playlist. 

Sign Groups 
Signs are grouped in different groups depending on event type. For example 
grouping of signs for regular events can be different than grouping of signs for 
displaying messages. 

StyleSet 
A StyleSets includes a collection of elements and is divided into 5 layers. It 
defines the size and position of each element in every layer. 

Layers 
Layers are use to define different level of object displaying signs. For more 
information about layers, refer to the Layer section. 

Stylesheet 

A stylesheet is an area of a display sign with a specific intended use. Each 
field has a type and a size. Also fields are positioned in 3 dimensions. For 
more information about styleset, layers and stylesheet, refer to the Layer and 
the Stylesheet type sections. 

Rooms 
This is rooms in the customers building etc. Door sign(s) outside the room is 
directly related with the room. Also wayfinding signs can be associated with 
door signs and thus indirectly with the room. 

Media Media are images, flash, playlist, RSS or video files. 

Customer 
A customer who use Ariadne UI to book event. For example a hotel with a 
sign system installed. 
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User 
A user is a human person using the Ariadne user interface. Users are in roles 
which determine their permissions and visibility of screen elements. 

External Booking 

system 
A SW application used by the customer to manages meeting and events. This 
applications is typically FMS (Facility management system) or EMS (Event 
management system) 

External Booking 
service 

A service in the Ariadne which are able to read specific XML event data and 
store the data in the Ariadne DB. Using this service locks the possibility to 
create Events in the Event view and the Room view  

 
Table 1. Definitions, Acronyms and Abbreviations 

Layer 
Layers are used to define different level of objects being displayed on screens. There are 5 static layers divided 
in three groups. The layers are at top of each other so content in a higher layer will cover content in lower 
layers. 

The layers concept regards the display at the Signs similar to windows on a computer desktop. If a window is 
opened it covers the background or a part of the background. If another window is at top the back, window will 
be fully or partially hidden. 

 Background Layer Group 
The background can be in two layers. The back layer can be an image or a color, this layer contain 
Background image. On top there can be a layer with Background object which can display media files such 
as image, flash or video. 

 Main Layer Group 
The main layer group consists of one layer. This layer displays the most information. Objects in this layer 
might be room template, way finding template, visitor welcome template, event object, information object, 
guest object and message. 

 Special Layer Group 
The special layer group consists of two layers. This group is intended for displaying high priority 
information. This information goes in front of other content as the layer is higher in the structure. The layer 
4 includes special objects or messages while the layer 5 contains only one special full screen object which 
will display a media covering the full screen. 

The objective of the layers concept is that there is always something at the display. If no Events have been 
created or some human or technical fault has occurred the display “falls back” at the lower layer.  

Stylesheet type 
A stylesheet is an area of a display sign with a specific intended use. Each stylesheet has a type and a size 
defined by the styleset assign for a sign. Styleset also positions a stylesheet in 3 dimensions to be located in 

which layer and where in that layer. 

All types of stylesheet are listed in the table below: 
 

Stylesheet Name State 1 State 2 

Room template 
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Way finding template 

  

Visitor welcome template 

  

Event object 

  

Information object 

  

Message   

Background image 

  

Background object 

  

Guest object 

  

Special object 

  

Special full screen object 

  

Public object 

  

 
Table 2. Stylesheet types 
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Ariadne Functionality Overview 
The Ariadne is a server-client system for controlling display of electronic signs. There is a server part with a 
web-based user interface for managing the content. The signs are clients of the system. The signs poll the 
server for instructions about what to display and displays the content at its monitor. The signs have different 
capabilities; some supports only text and images and other also rich media such as flash or video.  

The primary applications of sign systems are a combination of visual information: Directory to Events (way 
finding), Visitor information, Room Event information, Specific and general Information, Message. 

Each type of visual information can be displayed in separate windows on a sign and are prioritized according 
to the general Layer specification. 
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CHAPTER 2.  

Using Ariadne 

Getting Started 
To  start  Ariadne  in  your  Web  browser,  you  should  enter  the  Web application address. If you do not 
know the address, contact your IT administrator.   

By default, you can start Ariadne by entering the following URLs: http://<your server>/login.aspx 

Logging In 
To start, enter the Ariadne User Interface you have to log in first: 

1. Open your Web browser and enter a path to the Ariadne User Interface, depending on where you 
installed Ariadne 

2. The first page you will see is the login page on which you must enter the user’s ID and password.  

 
Figure 1. Login page 

 

3. Having entered user ID and password, click Login to open the Ariadne to proceed working with the 
application. 

If you login as a normal user, the web application will browse directly to the Ariadne User Interface.  

In case you login as a super admin or a local admin, the web application will browse to the Ariadne Admin 

page. You have to navigate back to the Ariadne IUI from there. 
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User Interface Items 
The screen for the user interface is horizontally divided into two main panes, namely the View Pane and the 
Details Pane. 

 
Figure 2. Ariadne main window 

View Pane 

The upper pane in the Ariadne User Interface is called the View Pane. This pane contains a menu with grey 
background called View Menu Pane at the left side and a horizontal Timeline at the right side. 

 
Figure 3. View Pane in normal view 

The View Pane features a horizontal tab strip which is the top level navigation. Selected tab determines which 
items are being displayed as bars in the timeline overview and sub tabs in Details Pane. For example, if the 
Events tab is selected, the bars are Events and Sub-events, the Details Pane consist of Summary, Data, 
Rooms, Sign and Design sub tab. The selected tab is colored with blue while the others are gray. 
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The View Pane could be expanded by dragging the line between the View Pane and Details Pane or fully 
expand to fill out the height in the browser window when user activates the hide Edit area button, System hide 
Edit area in the bottom of the browser window. 

 
Figure 4. View Pane expanded 

Timeline 
The timeline demonstrates all items at the selected date. The type of the items displayed depends on which 
main tab you are in. The current time is marked with a green vertical line. 
  
It is possible for user to select the span of the view and make the timeline narrow or wide by clicking the Month, 
Week, Day button at the upper right of the View Pane. 
 
The completely created and applied items are displayed in the timeline as a solid bar. The items which are not 
created completely or not saved will be shown as dash bars. 
 
In the timeline of Event or Room tab, there might be green line indicating the external booking event which is 
booked by another Facility management system or Event management system. 
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Buttons in View Pane 
 

Button Action  

 

Click the Ariadne icon to activate a menu: 

 Navigate to Admin: Select this to navigate to the 

Admin page of Ariadne 

 Revision History: provides a short summary about 
features of Ariadne production versions on Add-On- 
Product website 

 Delete: Delete a single event or an event in series.  

 Delete Series: delete an event in series or a series of 

events (recurring events) 

 Copy and Paste: produce a duplicate of the selected 

event. 

 Print Bookings: this function is only available in the 
Event and Room main tab. 

 Help: link to PDF document. 

 Logout: logging out of the system. 

 

Click the [View] button and select a view type to define the view 
of indexes in the View Menu Pane.  

 With label on bar 

 Without label on bar 
-------------------------- 

 Open all sub events 

 Close all sub events.  

The label on bar contains assigned room of the event. If the 
“Without label on bar” is selected the label will be shown when 
user mouses over the bar.  

 

Sorting types could be changed by clicking [Sort] button and 
select a type in the list.  

The available options are Event name (A>>Z); Event name 
(Z>>A); Start time (ascending and descending) and End 
time (ascending and descending).  

By default, the indexes are sorted alphabetically from A to Z. 

 There is a Search function to look for specific items by names. 

 Click “New event…” to start creating a new event. This button 
changes to New Special or New message depends on which 

main tab you are in. 

 These buttons are used to select the span of the view and make 
the timeline narrow or wide  
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 Click one of the three buttons to define the time range that the 
timeline will display. For example, if Month is selected (marked 
with blue) then all the events occur in the chosen month will be 
displayed in the View Pane. 

Details Pane 
The lower pane is called Details Pane. This page gets updated when user has clicked or selected an element 

in the View Pane. In the Details Pane the use sees details and works with the event’s elements (create or 
update fields).  

 
Figure 5. Details Pane 

The tab strip in the details view is secondary navigation. Clicking a tab in the Details Pane makes another 
aspect of the current selected item visible and does not change what item is being worked with.  
 
For example: User has selected the Events tab in the View Pane and has clicked a bar. The details for the 
selected Event are displayed in the Details Pane. The different aspects of this Event are; core data, booked 
rooms, signs to be displayed at and media.  
 
User can see the different aspects by clicking the tabs in the Details Pane. 

Buttons in Details Pane 
 

Button Action 

 

When user is creating or editing an event which has not been sent to any sign, if 
user clicks the [Cancel] button, every detail of the event in the system will be 
deleted and the Details pane will show a blank data tab for user to create a entirely 

new event. 

 Click this button to send the event to display on screen. 

 
Click this button to hide the Details pane and expand the View Pane to fill out the 
height in the browser window. 
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Events tab 
An Event, in this context, means a real life incident such as a conference, a seminar, or conduct of a course 
etc. The main event could have a number of sub events. For example a training course can include 2 hours of 
presentation which occurs in an auditorium followed by two hours work shop where the participants are split 
in groups and should be guided to small meeting rooms. The understanding of sub-events is important as it 
has implication for what and where the customer wants to display at signs. 
 
The purpose of the Event tab is for user to create and manage events.  
 
Select the Event tab, the indexes and bar in the View Pane will display all the events created in the specified 
time. By default, when you navigate from another tab to Event tab, the Data sub tab will appear as blank in the 
Details Pane for user to create new event immediately. Select any event in the View Pane will result in the 
Details Pane displaying the information of that event: 

 
Figure 6. Details Pane of Event tab 

The view area shows a list of all events in the specified time. 
The timeline displays when there are scheduled events, shown with a solid bar (for completely created and 
applied events) or dash bar for (not created completely or not applied events): 

 
Figure 7. View area 

If an event has one or more sub events it is marked with ‘+’ symbol on the left of its name (see Press 
Conference in the figure above). Clicking the ‘+’ symbol will open sub events. 
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Print Booking function 
The booking print function is intended to allow users to print a list of all meetings in the booking system within 
a particular time/date range. This function is only accessible in the Event and Room main tab. 

1. Click Ariadne icon to activate the main menu and select Print Booking function. 

 
Figure 8. Choose menu Print Bookings 

2. The PrintBooking dialog would appear for specifying print options: 

 
Figure 9. Print Booking 

a. Specify the time and date range of the print.  
b. In the Group By dropdown list, select the value by which events would be grouped by. 

  
3. Click OK to preview and print the booking list. In the first example of preview below, the grouping 

order is Date, and the sorting is Start Time and then End Time.  
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Figure 10. Print bookings preview 

The second example shows the grouping order is Room, and the sorting is Start Time and then End Time. 

 
Figure 11. Print bookings preview with filter 

Details Pane 
When the Event tab is selected, the Details Pane contains five sub tabs including Summary, Data, Rooms, 
Signs and Design. This section describes these sub tabs in detail.  

Summary 

 
Figure 12. Summary sub tab of Event tab 

The summary tab contains four areas displaying different information. The leftmost area with grey background 
shows Ariadne and application summary.  
 
The second area display information of the selected event which has been specified in the Data tab.  
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The Event Information of Rooms and Signs; Design and Media are displayed in the third and fourth area, 
respectively. 

Data 

 
Figure 13.  Data sub tab of Event tab 

The Data tab shows a Summary area with grey background. This area contains Data and Resources for the 
selected event.  
 
The area next to the Summary is the Main Event section. No matter user has selected a main event or a sub 
event in the View Pane, the main event is shown on the left and then one area for each sub-event. 
 
There is a blue line at the top of the area to indicate main or sub event you are currently working with. 

Main Event data area 
The Main Event section has several properties.  

 Name: Event name 

 Host: Host of the event.  

User can enter data manually in these two fields or click on the dropdown list to select a previous value. 
The Administrator can determine whether Name or Host is the primary field. The primary field is the 
required one and its content would represent the event on the View Pane. 

 Notes: This is to add internal comment or information and will not be displayed on the screens. 

 Start Date and End Date: Specify the start date and end date of the event by clicking the  button to 

open a calendar and select a date.  

 Start time, End time and Duration: Specify the start time then specify either an end time or select a 

duration by which the end time is calculated correspondingly. 

 Secondary: This field is to categorize the event as secondary event for displaying on Way finding 

signs. 

 Disable: Select this check box to prevent sending the event to signs. 
 
To book an event lasting multiple days, the end date selected must be different from the start date. It is possible 
to make the event recurring every specific time. For more information about recurring, refer to the Recurring 
section in this guide.  
 
Click Add logo button to select a logo for the event or click More Info button to enter further information of the 
event and then click Apply button to navigate to other sub tab to specify other aspect of the event. 
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Add Logo 
Click the Add Logo button to associate a logo with the event, an Add Logo area will be shown at the right side 

of the Main Event area. Select a logo in the list and drag it to the Logo area to assign the logo for the event. 
Click the Apply button to save. 

  
Figure 14. Add logo – Data sub tab of Event tab 

Button Action  

 
You can add more logo into the list by clicking the New Media button. The 
Upload Media window will come into view. 

 
You can edit logo by clicking the Edit Media button. The Edit Image window 

will come into view. 

 Select a logo and click this button to delete it. 

 Click this button to create a new folder for managing logos. 

 
Click this button to open Ariadne Logo Association. See Logo Association 
section for more details. 

 
Users are able to save a logo into local computer by selecting a logo and click 
the Download Logo button. 

 Go to root folder containing logos. 

Detail Information 

Click More Info button to open the Detail Information area for inserting extra information for the event.  

The fields displayed in this area are configured by administrators. See the Administrator Guide, Text line 
information section for more information about how to configure the Detail Information area. 
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Figure 15. Detail Information area 

Sub event data area 

When you finish creating a main event and click [Apply], new area for sub event gets visible in rightmost 

position.  
 

 
Figure 16. Sub event area 

A sub event only consists of main properties namely: Name, Notes, Start Time, End Time, Duration, and 
Recur every main.  

 Secondary: this field is to categorize the sub event as secondary event for displaying on Way finding 

signs 

 Disable: select this check box to not send the event to signs 

The objective of the Recur every Main check box is to set the event to recur at every date that the main event 

recurs. If the check box is not selected the Sub event will only take place at the start date of the main event.  
 
Click the Apply button to save the sub event or click reset to change all properties in sub event area set back 
to default content. 
 

NOTE: Start Date, End date, Start Time and End Time of sub event are limited in the duration of the main 

event. 
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Rooms 

 
Figure 17. Rooms sub tab of Event tab 

The purpose of the Rooms tab is to assign a venue to an event. All the available rooms at the event’s time will 

be displayed in the Available Rooms area.  
 
The Room Data area displays information of the selected room. Click  button to open the preview of the 

event with default room template of the selected room. (See the Design section for more information about 
room template).  
 
To assign room, select a room and click [Add] button or drag it to the Assigned Room area. 

 
Ariadne does not allow user to select more than one room for a given event. If more than one room is booked 
the user must create sub-events. If you have already selected a room and choose another afterward, the 
previous room will be replaced by the new one. 
 

Find Available room 

The Find Available room functions allow user to quickly look for a room that meets specific criteria: 

 
Figure 18. Find Available Room area 
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Signs 

 
Figure 19. Signs sub tab of Event tab 

By default all signs which have the templates related to the selected rooms are selected. If user wants to 
display the event at the default signs then he does not have to do anything in the signs subtab.  
 

NOTE: Signs with X symbol are offline signs, signs without X symbol are online signs. 

Design 

 
Figure 20. Design sub tab of Event tab 

Each room template object has a default room template specifying how the information will be shown.  
 
A room template is a set of fields which have defined fonts and colors. 
 
The purpose of Design sub tab is to allow user to select another room template applying to door object different 
from the default one.  
 
To assign a new room template, select it in the Available room template area and click [Add] button. 

  
You might preview how the event would be displayed on sign by clicking the  (preview) button. The preview 
window would appear as the sample below: 
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Figure 21. Event preview 

Working with Event 

How to Create an Event 

To create an event, follow this procedure: 

1. Click New Event, the Details Pane will show Data sub tab with a blank main event data area. Fill in 

the required data and click the [Apply] button to save the event in the database. 

2. From the Data tab, navigate to the Rooms tab to assigned room for the current event.  

3. Once you have done booking for a room, click Signs in the tab strip to navigate to the Signs subtab 

and assign signs to the event you have created.  

4. In the Design subtab, select a room template for the door object. 

5. Click Save to send the event to display on screen. 

To create sub event, fill in the information fields in data tab and click [Apply]. Then follow the step 2 to 5 as 

described above. 

NOTE 

 An event can only go to sign once it has a room assigned. 

 After selecting room in step 3, the signs (Signs subtab) and room template (Design subtab) will be 
assigned by default.  

 There is a time interval that event can be created in comparison with actual time. This value is 60 
days by default and can be configured in the Ariadne server web config file.  
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How to Edit an Event 

Select an event in the View pane to view and edit its information in the Details Pane. 

NOTE 

 When an event is saved for going to signs, if it is changed any details, the indicating bar will 
changed to dash bar. User has to click the [Save] button again to send the new edited event to 

signs. 

 If the time of event is altered causing resource conflict, the resource would be reset.  

 If the assigned room is changed, all the information specified in Signs and Design tabs will be 
reset. 

 It is not possible to edit an external booking event. 

How to Delete an Event 

 

 
To delete a recurring event, select it in the View 
pane then click the Ariadne icon and select [Delete 
series]. 

 

 

 
To delete a single event, select it in the View 
pane then click the Ariadne icon and select 
[Delete].  
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External Booking 

User is possible to book rooms by other booking systems, then import into Ariadne and send the event to 
digital signs. The bookings are imported by the External Booking Service (External event) and displayed as 
green lines on the Timeline. The green line is solid line if the booking is displayed on screen or dash line if it is 
not displayed on screen. 

In case of an external event and internal event (booked by Ariadne IUI) having resource conflict, the internal 
booking will have higher priority and be displayed on signs. The external booking is still kept in the system and 
will be displayed on screen in case the internal booking is edited or deleted to solve the recourse conflict. 

The small tabs in the Details Pane are only used for viewing the details of external booking, user cannot edit 
any information of external event.  

Guests tab 
A Guest event occurs when a guest visits a company. Main guest event will be displayed in every sign which 
contain visitor welcome template. Guest sub event can be understood as event for guest.  
 
For example: Investors are visiting the company, their names will be displayed on welcome signs. The visitors 
then take part in meeting with the management board. This meeting will be booked as a guest sub event which 
is the same as a typical sub event. 

 
Figure 22. View Pane of Guests tab 

The view area shows a list of all guest events in the specified time. 

The timeline displays when scheduled guest events take place, shown with a solid bar (for completely 
created and applied events) or dash bar (for not created completely or not applied events). 

If an event has one or more sub events it is marked with “+” symbol for details on sub events. Activating the 
“+” symbol will open sub events. 

Details Pane of Guests tab 

When the Guest tab is selected and if you are working with the main guest event, the Details Pane will contain 
two sub tabs including Summary and Data. This section describes these sub tabs in detail.  

NOTE: If you are working with the sub guest event, the Details Pane will contain five sub tabs including 

Summary, Data, Room, Sign and Design. The nature of sub guest event is the same with typical sub event. 
For information about Room, Sign and Design sub tabs for sub guest event, refer to the corresponding sections 

described in the Event tab section above. 
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Figure 23. Tabs in Details Pane of a sub guest event 

Summary 

 
Figure 24. Summary sub tab of Guest tab 

The summary tab contains four areas displaying different information.  

The leftmost area with grey background shows Ariadne and application summary.  

The second area display information of the selected Guest event.  

The Guest Event Information of Rooms and Signs; Design and Media are displayed in the third and fourth 
area, respectively. 
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Data 

 
Figure 25. Data sub tab of Guest tab when working with main event 

The data tab shows a Summary area with grey background. This area contains Data and Resources for the 
selected event.  

The area next to the Summary is the main guest event. No matter if user has selected a main event or a sub 
event in the View Pane, the main event is shown leftmost and then one area for each sub-event. 

There is a blue line at the top of the area to indicate which event you are currently working with. 

Main Event data area 

The Main Event has several properties.  

 Organization: the event name 

 Organizer and Guests fields are to enter the name of the host and guests. 

 Note: this is to add internal comment or information and will not be displayed on the screens. 

 Start Date and End Date: specify the start date and end date of the event by clicking the  button to 

open a calendar and select a date.  

 Start time, End time and Duration: specify the start time then specify either an end time or select a 

duration by which the end time is calculated correspondingly. 

To book an event lasting multiple days, select the end date differently from the start date. It is possible to make 
the event recur every specific time. For more information about recurring, refer to the Recurring section in this 
guide.  
Click Add logo button to select a logo for the event and then click the Apply button to navigate to other sub 

tab to specify other aspect of the event. 

NOTE: A main guest event will only go to signs which contain visitor welcome template. Along with the guest 

event, the media sub tab is also available for you to send media file to display on screen.  

Preview 

You might be able to preview the guest event on guest template by clicking the preview   button. In the 
preview window that appear on the screen, select a guest template in the dropdown list to preview how the 
event would appear on a screen with the selected template. 
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Figure 26. Guest event preview 

Sub event data area 

When you finish creating a main and click apply new area for sub event gets visible in rightmost position. A 
sub event only consists of main properties namely Name, Notes, Start Time, End Time, Duration, and Recur 
every Main.  

 Secondary: This field is to categorize the sub event as secondary event for displaying on Way finding 
signs 

 Disable: Select this check box to prevent sending the event to signs 

 Recur every Main: This check box is to set the event to recur at every date that the main event recurs. 

If the check box is not selected the Sub event will only take place at the start date of the main event.  

Click [Apply] button to save the sub event or click [Reset] to change all properties in sub event area set back 
to default content. 

NOTE: Start time and end time of sub event are limited in the time range when the main event occurs. 

After clicking [Apply] button, user can be able to navigate to other sub tab to specify other aspects of the sub 

guest event. 

Working with Guest Event 

How to Create a Guest Event 

To create a main guest event, click New Guest, the Details Pane will show Data sub tab with a blank main 
event data area. Fill in the required data and click [Apply] button to save the event in the database.  
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If you want to book for a media to display along with the guest event, navigate to the Media tab to book for 
guest object. 

After creating a main guest event, to create a sub guest event, follow this procedure: 

1. Fill in the required data in the Sub event data area and click the [Apply] button to save the event in 

the database. 
2. From the Data tab, navigate to the Rooms tab to assigned room for the current event.  

3. Once you have done booking for a room, click Signs in the tab strip to navigate to the Signs tab and 

assign signs to the event.  
4. In the next tab, the Design tab, select a room template for the door object. 

5. Click Save to send the event to display on screen. 

NOTE 

 A sub event can only go to sign once it has a room assigned. 

 After selecting room in step 3, the signs (Signs subtab) and room template (Design subtab) will be 
assigned by default.  

 User can only create event in the main tabs which he has permission to create event in. 

How to Edit a Guest Event 

Select an event in the View pane to view and edit its information in the Details Pane. 

NOTE 

 When an event is saved for going to signs, if it is changed any details, the indicating bar will changed 
to dash bar. User has to click the Save button again to send the new edited event to signs. 

 If the time of event is altered causing resource conflict, the resource would be reset.  

 If the assigned room is changed, all the information specified in Signs, Design and Media tab will 
be reset. 

How to Delete a Guest Event 
Deletion of a guest event is implemented similarly to deletion of an event.

 

Information tab 
The purpose of this tab is to book media objects on signs to display information (pictures, flash or video etc.)  

Select the Information tab, the indexes and bar in the View Pane will display all the Information events created 
in the specified time. By default, when you navigate from another tab to Background tab, the Data sub tab will 
appear as blank in the Details Pane for user to create new Information immediately. Select any Information 
event in the View Pane will result in the Details Pane displaying the information of that event. 
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View Pane 

 
Figure 27. View Pane of Information tab 

The view area shows a list of all information events in the specified time. 

The timeline display when there are scheduled information events, shown with a solid bar (for completely 
created and applied events) or dash bar for (not created completely or not applied events). 

If an event has one or more sub events it is marked with “+” symbol for details on sub events. Activating the 
“+” symbol will open sub events.  

Details Pane 
When the Information tab is selected, the Details Pane will contain four sub tabs including Summary, Data, 
Signs and Media. This section describes these sub tabs in detail.  

NOTE: the Signs and Media sub tab are only available when you are working with the sub information event. 

The main information event is only used for grouping information events.  

Summary 

  
Figure 28. Summary sub tab of Information tab 

The summary tab contains four areas displaying different information. The leftmost area with grey background 
shows Ariadne and application summary.  

The second area display information of the selected event which has been specified in the Data tab.  

The Information of Signs and Media are displayed in the third and fourth area, respectively. 
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Data 

 
Figure 29. Data sub tab of Information tab 

The data tab shows a Summary area with grey background. This area contains Data and Resources for the 
selected event.  

The area next to the Summary is the main Information event data area. No matter if user has selected a main 
event or a sub event in the View Pane, the main event is shown next to the Summary and then one area for 
each sub-event. 

There is a blue line at the top of the area to indicate which main or sub event you are currently working with. 

Main Event data area 

The Main Event has several properties.  

 Name: Event name 

 Notes: This is to add internal comment or information and will not be displayed on the screens. 

 Start Date: Specify the start date of the event by clicking the  button to open a calendar and select 

a date.  

 End by: Specify the end date of the event by clicking the  button to open a calendar and select a 
date.  

 Start time, End time and Duration: specify the start time then specify either an end time or select a 

duration by which the end time is calculated correspondingly. 

To book an event lasting multiple days, select the end date differently from the start date. It is possible to make 
the event recur every specific time. For more information about recurring, refer to the Recurring section in this 
guide.  
Click the [Apply] button to navigate to other sub tab to specify other aspect of the event. 

Sub event data area 

When finish creating a main and click [Apply] button, new area for sub event gets visible in rightmost position. 
A sub event only consist of main properties namely the Name, Note, Start Time, End Time, Duration, and 
Recur every Main.  

The objective of the Recur every Main check box is to set the event to recur at every date that the main event 

recurs. If the check box is not selected the Sub event will only take place at the start date of the main event.  

Click the [Apply] button to save the sub event or click reset to change all properties in sub event area set back 
to default content.  

After clicking [Apply] button, user can be able to navigate to other sub tabs to specify other aspect of the 

event. 
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NOTE: Start Time and End Time of sub event are limited in the time range when the main event occurs. 

Signs 

 
Figure 30. Signs sub tab of Information tab 

There are no default rules for selecting Signs for an Information Event. All Signs which have not been booked 
should be selectable for Information Events. 

NOTE: Signs with X symbol are offline signs, signs without X symbol are online signs. 

 
To assign sign, select a sign and click [Add] button or drag it to the Assigned Signs area. 

The leftmost area of the Signs sub tab displays information of the selected sign. 

Media 

 
Figure 31. Media sub tab of Information tab 

The upper area (Assigned Signs) presents a list of all assigned signs.  

Select a signs, the layer 3 of the sign’s styleset will be shown at the “Select and Preview” area. However, only 
the objects which can be booked by this main tab will be shown. In this tab, user can only book for information 
and public objects. 
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Select an object in the preview area, all the available media will be listed in the media field. Select a media 
and drag it into the preview area. 

The Media subtab also features Playlist Editor, Editor and Logo Association. For more information about these 
two features, refer to the Media tab section in this guide. 

NOTE: E-sign-NG type can only support images, so when you select an object in the styleset of this sign, 

only images will be shown. 

Working with Information Event 

How to Create an Information Event 
To create an event, follow this procedure: 

1. Click New Information, the Details Pane will show Data sub tab with a blank main event data area. Fill 

in the required data and click [Apply] button to save the event in the database. 

2. From the data tab, navigate to the Signs subtab and assigned signs for the event.  

3. Go to the Media tab afterward to book for a media to display it along with the event. 

4. Click Save to send the event to display on screens. 

To create sub event, fill in the information in data tab and click [Apply]. Then follow the step 2 and step 3 
described above. 

NOTE: There is a time interval that event can be created in comparison with actual time. This value is 60 

days by default and can be configured in the Ariadne server web config file.  

 

How to Edit an Information Event 
Select an event in the View pane to view and edit its information in the Details Pane. 

NOTE 

 When an event is saved for going to signs, if it is changed any details, the indicating bar will change 
to dash bar. User has to click the Save button again to send the new edited event to signs. 

 If the time of event is altered and cause resource conflict, the resource would be reset.  

 If the assigned signs are changed, all the information specified in Media tab will be reset. 

How to Delete an Information Event 

Deletion of an information event is implemented similarly to deletion of an event. 

Message tab 
Messages are textual information which is sent as RSS to the signs. It is displayed as scroll text in the bottom 
of the screen. 

Select the Message tab, the indexes and bar in the View Pane will display all the message events created in 
the specified time. By default, when you navigate from another tab to Message tab, the Data sub tab will appear 
as blank in the Details Pane for user to create new message immediately.  

Select any message event in the View Pane will result in the Details Pane displaying the information of that 
event. The Message event type does not have sub events. 
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View Pane 

 
Figure 32. View Pane of Message tab 

The view area shows a list of all message events in the specified time. 

The timeline displays when there are scheduled message events, shown with a solid bar (for completely 
created and applied events) or dash bar (for not created completely or not applied events). 

Details Pane 
This section describes sub tabs in the Details Pane when Message tab is selected.  

Summary 

 
Figure 33. Summary sub tab of Message tab 

The summary tab contains four areas displaying different information. The leftmost area with grey background 
shows Ariadne and application summary.  

The second area display information of the selected event which has been specified in the Data tab.  

The Event Information of Signs and Media are display in the third and fourth area, respectively. 
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Data 

 
Figure 34. Data sub tab of Message tab 

The data tab shows a Summary area with grey background. This area contains Data and Resources for the 
selected event.  

The area next to the Summary is the Message event which contain has several properties.  

 Name: message name 

 Content: the message content which is going to be displayed on signs.  

 Notes: this is to add internal comment or information and will not be displayed on the screens. 

 Start Date: specify the start date of the event by clicking the  button to open a calendar and select 

a date.  

 End Date: specify the end date of the event by clicking the  button to open a calendar and select a 

date.  

 Start time, End time and Duration: specify the start time then specify either an end time or select a 

duration by which the end time is calculated correspondingly. 

 Layer: select the layer you want to display the message.  

- Layer 3: the middle layer which displays normal event. 

- Layer 4: the layer used to display special event. 

To book an event lasting multiple days, select the end date differently from the start date. It is possible to make 
the event recurring every specific time. For more information about recurring, refer to the Recurring section 
in this guide.  
After entering the above values, click the [Apply] button to temporarily save the event in the database, a dash 

bar indicating the created event will be put on view on the timeline. Also after clicking Apply button, user can 
be able to navigate to sign sub tab to specify which signs the message will be displayed. 
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Signs 

 
Figure 35. Signs sub tab of Message tab 

There are no default rules for selecting Signs to a Message Event. Those Signs which have not been booked 
should be selectable for Message Events. 

NOTE: Signs with X symbol are offline signs, signs without X symbol are online signs. 

 
To assign sign, select a sign and click [Add] button or drag it to the Assigned Signs area. 

The leftmost area of the Signs sub tab displays information of the selected sign. 

Working with Message 

How to Create a Message 

To create a new message, follow this procedure: 

1. Click New Message, the Details Pane will show Data sub tab with a blank Message event data area. 

Fill in the required data and click the [Apply] button to save the event in database. 

2. Click Signs in the tab strip to navigate to the Signs subtab and select which signs the message will be 

displayed on.  

3. Click [Save] to send the event to display on screens. 

NOTE: There is a time interval that event can be created in comparison with actual time. This value is 60 

days by default and can be configured in the Ariadne server web config file. 

 

How to Edit a Message 
Select an event in the View pane to view and edit its information in the Details Pane. 

NOTE 

 When an event is saved for going to signs, if any of its details is changed, the indicating bar will 
change to dash bar. User has to click the [Save] button again to send the new edited event to signs. 

 If the time of event is altered and causes resource conflict, the resource would be reset.  

 If the assigned sign is changed, all the information specified in Signs, Design and Media tab will be 
reset. 
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How to Delete a Message 
Deletion of a message is implemented similarly to deletion of an event. 

Rooms tab 
The Rooms tab is not for another Event type. The objective of Rooms tab is to view all Events relevant for 
Rooms booking, seen from the Rooms perspective. 

Select the Room tab, the indexes and bar in the View Pane will display all the rooms and the event created in 
those rooms. By default, when you navigate from another tab to Event tab, the Summary sub tab will appear 
in the Details Pane showing information of the room.  

Select a room, the [New event] button will now be able to be pressed to create a new event 

View Pane 

 
Figure 36. View Pane of Room tab 

The view area shows a list of all rooms in the system. 

The timeline display when there are scheduled events in the rooms, shown with a solid bar (for completely 
created and applied events) or dash bar for (not created completely or not applied events). 

Print Booking function 
The booking print function is intended to allow the users to print a list of all meetings in the booking system 
within a particular time/date range. This function is only accessible in the Events and Rooms main tab. For a 
detailed instruction to use this feature, please click here.  

Details Pane 
When the Rooms tab is selected, the Details Pane will contain four sub tabs including Summary, Data, Signs 
and Design. This section describes these sub tabs in detail.  
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Summary 

 
Figure 37. Summary sub tab of Room tab 

The summary tab contains four areas displaying different information.  

The leftmost area with grey background shows Ariadne and application summary.  

The second area displays information of the selected room.  

The Event Information of Rooms and Signs; Design and Media are displayed in the third and fourth area, 
respectively. 

Data 

 
Figure 38. Data sub tab of Room tab 

The data tab shows a Summary area with grey background. This area contains Data and Resources for the 
selected event. 

The area next to the Summary is the main event. In the Rooms tab, you cannot create sub event. 

Event data area 

Refer to this section for more details. 

Add Logo 

Refer to this section for more details. 

Detail Information 

Refer to this section for more details 
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Signs 
Refer to this section for more details.  

Design 
Refer to this section for more details 

Special tab 
The objective of the Special Event is to book and display important event on signs regardless that any other 
kinds of events have been created. 

Select the Special tab, the indexes and bar in the View Pane will display all the background events created in 
the specified time. By default, when you navigate from another tab to Background tab, the Data sub tab will 
appear as blank in the Details Pane for user to create new background immediately. Select any event in the 
View Pane will result in the Details Pane displaying the information of that event. 

View Pane 

 
Figure 39. View Pane of Special tab 

The view area shows a list of all special events in the specified time. 

The timeline display when there are scheduled special events, shown with a solid bar (for completely created 
and applied events) or dash bar for (not created completely or not applied events). 

Details Pane 
This section describes sub tabs in the Details Pane when Special tab is selected.  
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Summary 

 
Figure 40. Summary sub tab of Special tab 

The summary tab contains four areas displaying different information.  

The leftmost area with grey background shows Ariadne and application summary.  

The second area displays information of the selected event which has been specified in the Data tab.  

The Event Information of Signs and Media are displayed in the third and fourth area, respectively. 

Data 

 
Figure 41. Data sub tab of Special tab 

The data tab shows a Summary area with grey background. This area contains Data and Resources for the 
selected event.  

The area next to the Summary is the Special event which has several properties.  

 Name: event name 

 Notes: this is to add internal comment or information and will not be displayed on the screens. 

 Start Date and End Date: specify the start date and end date of the event by clicking the  button to 

open a calendar and select a date.  

 Start time, End time and Duration: specify the start time then specify either an end time or select a 

duration by which the end time is calculated correspondingly. 

 Layer: select the layer on which you want to display the message.  

- Layer 4: the special layer which displays special event and message. 
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- Layer 5: the top layer which only displays special event on full screen. 

To book an event lasting multiple days, select the end date differently from the start date. It is possible to make 
the event recurring every specific time. For more information about recurring, refer to the Recurring section 
in this guide.  
After entering the above values, click the [Apply] button to temporary save the event in the database, a dash 

bar indicating the created event will be put on view on the timeline. Also after clicking Apply button, user can 
be able to navigate to sign sub tab to specify which signs the message will be displayed. 

Signs 

 
Figure 42. Signs sub tab of Special tab 

There are no default rules for selecting Signs to a Special Event. All Signs which have not been booked should 
be selectable for Special Events. 

NOTE: Signs with X symbol are offline signs, signs without X symbol are online signs. 

To assign sign, select a sign and click Add button or drag it to the Assigned Signs area. 

The leftmost area of the Signs sub tab displays information of the selected sign. 

Media 

 
Figure 43. Media sub tab of Special tab 
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The upper area presents a list of all assigned signs.  

Selects a sign, the layer 4 or 5 (depend on which layer you have selected in data sub tab) of the sign’s styleset 
will be shown at the preview area. However, only the objects which can be book by this main tab will be shown. 
In this tab, user can only book for special and public object. 

Select an object in the preview area, all the available media will be listed in the media field. Select a media 
and drag it into the preview area. 

The Media subtab also features Playlist Editor, Editor and Logo Association. For more information about these 
two features, refer to the Media tab section in this guide. 

NOTE: E-sign-NG type can only support images, so when you select an object in the styleset of this sign, 

only images will be shown. 

Working with Special Event 

How to Create a Special Event 

To create a new special event, follow this procedure: 

1. Click New Special, the Details Pane will show Data sub tab with a blank Special event data area. Fill 

in the required data and click the apply button to save the event in the database. 

2. Click Signs in the tab strip to navigate to the Signs subtab and assigned signs for the event.  

3. Go to the Media tab afterward to book for a media. 

4. Click Save to send the event to display on screens. 

NOTE: There is a time interval that event can be created in comparison with actual time. This value is 60 

days by default and can be configured in the Ariadne server web config file.  

How to Edit a Special Event 
Select an event in the View pane to view and edit its information in the Details Pane. 

NOTE 

 When an event is saved for going to signs, if any of its details is changed, the indicating bar will 
change to dash bar. User has to click the Save button again to send the new edited event to 

signs. 

 If the time of event is altered and causes resource conflict, the resource would be reset.  

 If the assigned signs are changed, all the information specified in Media tab will be reset. 

How to Delete a Special Event 
Deletion of a special event is implemented similarly to deletion of an event. 

Background tab 
The objective of the Background tab is to define the style and visual appearance of the background of the sign. 
The background is visible if no Events are scheduled at any given time. 

The background tab allows users to change background during the day or by occasions. For example: In the 
mornings a sunrise picture could be displayed as background and in evenings a midnight blue theme could be 
displayed. The background event type does not have sub events.  
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Select the Background tab, the indexes and bar in the View Pane will display all the background events created 
in the specified time. By default, when you navigate from another tab to Background tab, the Data sub tab will 
appear as blank in the Details Pane for user to create new background immediately.  

Select any background event in the View Pane will result in the Details Pane displaying the information of that 
event. 

View Pane 

 
Figure 44. View Pane of Background tab 

The view area shows a list of all information events in the specified time. 

The timeline displays when there are scheduled information events, shown with a solid bar (for completely 
created and applied events) or dash bar for (not created completely or not applied events). 

Details Pane 
This section describes sub tabs in the Details Pane when Background tab is selected.  

Summary 

 

Figure 45. Summary sub tab of Background tab 

The summary tab contains four areas displaying different information.  

The leftmost area with grey background shows Ariadne and application summary.  

The second area displays information of the selected event which has been specified in the Data tab.  

The Event Information of Signs and Media are display in the third and fourth area, respectively. 
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Data 

 
Figure 46. Data sub tab of Background tab 

The data tab shows a Summary area with grey background. This area contains Data and Resources for the 
selected event. 

The area next to the Summary is the Background event which has several properties.  

 Name: background event name 

 Note: this is to add internal comment or information and will not be displayed on the screens. 

 Start Date and End Date: specify the start date and end date of the event by clicking the  button to 

open a calendar and select a date.  

 Start time, End time and Duration: specify the start time then specify either an end time or select a 

duration by which the end time is calculated correspondingly. 

 In the Type dropdown list, select a type for the background event:  

- Image type is of layer 1, the lowest layer of a styleset. This type has to be set as full screen. 

- Object type is of layer 2.  

Once you click the [Apply] button, this function will be disabled; you will not be able to change the type of a 

background event. 

To book an event lasting multiple days, select the end date differently from the start date. It is possible to make 
the event recurring every specific time. For more information about recurring, refer to the Recurring section 
in this guide.  
After entering the above values, click the [Apply] button to temporary save the event in the database, a dash 
bar indicating the created event will be put on view on the timeline. Also after clicking [Apply] button, user is 
able to navigate to Signs sub tab to specify which signs the message will be displayed. 



 

CHAPTER 2 

Using Ariadne 43 
 

 

Signs 

 
Figure 47. Signs sub tab of Background tab 

There are no default rules for selecting Signs to a Background Event. All Signs which has not been booked 
should be selectable for Background Events. 

NOTE: Signs with X symbol are offline signs, signs without X symbol are online signs. 

 
To assign sign, select a sign and click Add button or drag it to the Assigned Sign area.  

The leftmost area of the Signs sub tab displays information of the selected sign. 

Media 

  
Figure 48. Media sub tab of Background tab 

The upper area presents a list of all assigned signs.  

Select a signs, the layer 3 of the sign’s styleset will be shown at the preview area. However, only the objects 
which can be booked by this main tab will be shown. In this tab, user can only book for event and public object. 

Select an object in the preview area, all the available media will be listed in the media field. Select a media 
and drag it into the preview area. 



 

CHAPTER 2 

Using Ariadne 44 
 

 

The Media subtab also features Playlist Editor, Editor and Logo Association. For more information about these 
two features, refer to the Media tab section in this guide. 

NOTE:  E-sign-NG type can only support images, so when you select an object in the styleset of this sign, 

only images will be shown. 

 

If the background event has image type, there 
will be a Color button appear below the preview 

area. Click on this button to open a dialog which 
is used to select a background color. 

 

Working with Background Event 

How to Create a Background Event 

To create a new Background event, follow this procedure: 

1. Click New Background, the Details Pane will show Data sub tab with a blank Special event data area. 

Fill in the required data and click the apply button to save the event in the database. 

2. Click Signs in the tab strip to navigate to the Signs subtab and assigned signs for the event.  

3. Go to the Media tab afterward to book for a media. 

4. Click Save to send the event to display on screens. 

How to Edit a Background Event 

Select an event in the View pane to view and edit its information in the Details Pane. 

NOTE 

 When an event is saved for going to signs, if any of its details is changed, the indicating bar will 
changed to dash bar. User has to click the Save button again to send the new edited event to signs. 

 If the time of event is altered and cause resource conflict, the resource would be reset.  

 If the assigned signs are changed, all the information specified in Media tab will be reset. 

 

How to Delete a Background 

Deletion of a background event is implemented similarly to deletion of an event. 
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Signs tab 
The main purpose with the sign tab is maintenance and handling of sign groups. 

View Pane 

 
Figure 49. View Pane of Signs tab 

The view area shows a list of all signs and signs groups. 

The timeline shows when there are scheduled events of any kind on the sign or the signs group, shown with a 
solid bar. 

Sign groups only show events which are scheduled for the whole group. 

If a sign or a sign group has one or more events scheduled it is marked with “+” symbol for detail on events. 
Activating the “+” symbol will create “sub” events for each event scheduled on this sign or sign group. The sub 
indexes are the name of the specific event. 

Details Pane 

When the Signs tab is selected, the Details Pane will contain two sub tabs including Data and Sign Groups. 
This section describes these sub tabs in detail.  

Data 

 
Figure 50. Data sub tab of Signs tab 
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The data tab shows a Summary area with grey background. This area contains Data and Resources of the 
Ariadne and application summary. 

The Sign Status area features the On-line signs and Off-line signs tables. These two tables list all the online 

and offline signs in the system.  

A sign will access to the schedule file to get information for displaying every specific time interval. When there 
is access to this file, the access time will be saved into the database. Ariadne will compare this access time 
with the current time, if it is greater than 30 minutes (this value is configurable), then the sign will be shown in 
the offline column, which means that its status are offline and vice versa.  

The bars for Off-line signs are displayed as red. If there is any offline sign in the system, the Data sub tab of 
Signs tab and Signs tab in the view area will get red to alert users. 

Below the Sign Status area is the Sign Information area which shows detail information about the selected 

sign. In this area you have the following information: 

 Sign name: the name of selected sign. 

 Customer ID: Ariadne unique customer ID. 

 Display Class: the type of sign. 

 Display Height: sign height in pixels. 

 Display Width: sign width in pixels. 

 Schedule URL: this URL is a link to the signs schedule file on the server. The file contains information 

about contents to be displayed on the screen. 

 Registration URL: this URL is a link to the signs registration on the server. The sign will only be 

registered when it is being installed or if changes are made to the network settings or the firmware of 
the sign. 

 Poll rate: indicates, in seconds, how often the sign must check the server for changes. 

 Time zone: the time zone of the sign based on GMT. 

 UTC offset: time changes in relation to UTC. This setting is used in connection with daylight saving 

time, indicating in seconds. 

 Display ID: a unique MAC address on the Ethernet card in the sign. 

 Display URL: a URL link to setup the program for the sign. Click on the link to go to the sign’s setup 

program.  

 Info IP: The IP address of the sign 

If you select a sign group only the signs status is shown.  
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Sign Group tab 

 
Figure 51. Sign Groups sub tab of Signs tab 

Sign Group tab contain seven columns displaying all sign groups of the Ariadne system.  

It is possible to create sign groups for different type of event: 

 Special: All signs which have special elements in the styleset 

 Event: All signs which have room template and event object in the styleset 

 Guest: All signs which have Visitor Welcome template and guest object in the styleset 

 Information: All signs which have an Information element in the styleset 

 Message: All signs which have a message element in the styleset 

 Room: All signs which have a room element in the styleset 

 Background: All signs ordered by size.  

If you select a group only signs with same resolution is shown. When you start to make a new group and you 
have selected the first signs only signs with same pixel resolution will be shown in the lower area. (Background 
images have to be PNG and same pixel size as the screen). 

The Upper edit area shows the created sign groups and the lower edit area shows all the signs available for 
the selected sign group. 

The signs in the lower area will first be shown when you click in one of the upper signs group areas. 

Create/Edit a Sign Group 

To create a new sign group in a certain column: 

1. Click New Sign Group. 

2. Enter the name for the new group in the newly appearing field and press Enter.  
3. The new group will be listed in the column. 
4. Select the new group, the lower edit area will display all the signs which have the appropriate 

element with the sign group type. 
5. Select signs by checking the checkbox next to a sign and click [Add] to finish. 

To edit an existing group, repeat step 4 and 5 above. Or you can rename a group by double click at the group 
name and then enter a new name for it. 

To delete a sign group, select it and click [Remove]. 
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Media tab 
The objective of Media tab is to see where the media is used, to manage media and associate logos with 
company names. 

View Pane 

 
Figure 52. View Pane of Media tab 

The view area shows a list of all media which are used in other tabs. 

The timeline shows when there are scheduled events using the media, shown with a solid or dash bar. 

If a media is used by one or more events, it is marked with “+” symbol for detail on events. Activating the “+” 
symbol will expand sub-indexes which are the name of the specific event. 

Details Pane 

 
Figure 53. Details Pane of Media tab 
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The Media Properties area displays information of the selected media while the Find media area features the 
search function to quickly look for a specific media file in the database. 

Details Pane contains two media areas which are used to maintain all media files of a customer by the buttons 
listed below: 

Button Description  

 New Media  

 Edit Media  

 Delete Media  

 New Folder  

 Playlist Editor  

 
Editor  

 Logo Association  

 Clean up 

 Download 

 Root 

 

 New Media button: Upload media function allows you to upload more than one file at the same time. 
When you upload,  you  have  to  specify  which  type  of media  you  want  to upload.  

- New Image: Images can be stored in all size in the following formats: .png, .gif, .jpg, .bmp and 
used in templates, playlists or assigned to an object on a layer of sign.  

Upload Image: 

 
Figure 54. Upload media - Image 

1. Click on New Media button. 

2. Select Image item in the dropdown list at the upper right of the window.  

3. Click [Browse] button to select image or enter path linking to the file.  
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4. Select image(s) that you want to upload.  

5. Click [Upload] button.  

- New Flash: Flash in .swf format can be used in playlists or assigned an object on layer 2, 3, 4 
of sign.  

Upload Flash: Procedure to upload flash is similar to one to upload image. 

- New Movie: Videos in formats of .avi, .wmv, .mpg, .mov can be used to assign to an object of 
a layer 2, 3, 4 on sign.  

Upload Movie: Procedure to upload flash is similar to one to upload image 

- New Logo: Logo in .gif, .png, .jpg formats can be uploaded.  

Upload Logo: Procedure to upload flash is similar to one to upload image 

- New Pictogram: animations in .gif, .png, .jpg formats are used in wayfinding.  

Upload Pictogram: Procedure to upload flash is similar to one to upload image 

- New URL: URL can be linked and used in playlist or assigned to an object on layer 2, 3, 4 of 
sign. For example: the URL http://photobucket.com/logo.jpg can be typed into the appropriate 
field.  

Upload URL:  

  
Figure 55. Upload media - URL 

1. Click on [New Media] button.  

2. Enter name for the URL in Media Name field 

3. Enter URL into File Name field 

4. Click [Upload] button. 

- New RSS: RSS feed is indicated in a URL format. For example: http://rss.asdf.dk/tv2.rss   

NOTE: RSS feeds can be only used in version 2.0.  

Upload RSS: Procedure to upload flash is similar to one to upload URL 

 Edit Media button: Open Edit Image window. 

http://photobucket.com/logo.jpg
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Figure 56. Edit Image window 

 Delete Media button: Select a logo and click this button to delete it. 

 New Folder button: Create new media folder for file management purpose. 

 
Figure 57. Create sub folder 

 Playlist Editor button: Open Ariadne Playlist Editor. See Playlist section for more details. 

 Editor button: Open Ariadne Editor. See Editing Pictures section for more details. 

 Logo Association button: Open Ariadne Logo Association. See Logo Association section for more 

details. 

 Cleanup button: Open Delete unused media window. You can select, preview and delete unused 

media in this window. 
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Figure 58. Delete unused media window 

 Download button: Download media file to the local computer. 

 
Figure 59. Download media 

NOTE: The first time of using download function, user might see the message box asking to increase available 

storage of Silverlight. Please click [Yes] to increase the storage to 200Mb for Ariadne application. By then, 

users will be able to download media file which has file size up to 200Mb. 
 



 

CHAPTER 2 

Using Ariadne 53 
 

 

 
Figure 60. Microsoft Silverlight message 

 Root button: Go to root folder containing media. 

 

Logo Association 
The association feature provides a connection between the organizer (host) and the logo. By selecting a host 
name and dragging a logo into the logo section, the association between the selected host and the logo will 
be created. 

  
Figure 61. Ariadne Logo Association window 

After the connection is created, whenever an event is created with the host, the logo (in the association with 
the host) will automatically be available. As in the screenshots, the logo “Add-On Products” is associated with 
the host “AOP”. 
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Figure 62. Logo associated with the host 

NOTE: The association can only work with logo type. You can look for this type of image in Media folder. See 

the next section “Find function” for more details. 

Find function 
The find function provides you the ability to look 
for specific media files with criteria such as Name 
or Type of media. 

 
Figure 63. Find function 

In the Media subtab of Background tab, Special 
tab or Information tab, there is one more option 
namely “Only Compatible”.  

- If this option is not selected, all media files are 
available. 

- If this option is selected, only media files 
compatible for the concerned tab will be 
available: 

 If the Media type is Image:  
 

Figure 64. Find Media in Background tab 
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- For Layers 2, 3, 4, 5: only images 
are available. 

- For Layer 1: only images with the 
same resolution as the screen 
are available. 

 If the Media type is not Image: available 
media files includes Image, Flash, Movie, 
Animation, Link, RSS and Playlists. 

Playlist 
A playlist consist of one or more elements containing media files of the same types and displayed in pre-
defined time interval. 

Create new playlist 

To create a playlist: 
 

1. In the Ariadne 
Playlist Editor main 
window, click New 
Playlist button 

 

 

 
2. Enter a name and 

choose type for the 
new playlist. Then 
click [Next] 
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3. Select media files 

and drag it into the 
playlist. 
You can also 
upload new media 
by clicking [+] icon 
and then browse to 
the file. 

 

 
4. Specify duration for 

each selected 
media and click 
[Save Playlist] to 
finish. 
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Maintain playlists 

 
In the Ariadne Playlist Editor main window, you can see a list 
of the available playlists. 
 
You can add a new one, edit or delete existing one by 
clicking the corresponding icons on the menu. 
 
To change the media files or duration in the playlist, you can 
drag the media files (in the playlist) to the media folder and 
vice versa. 
 
Click [Save Playlist] to save. 

 
  

 

Ariadne Editor 
Ariadne Editor is a tool used to edit existing pictures 

Editing picture 

Ariadne Editor provides you with the editing pictures function.  
 

Button Action 

 
The arrow button is used to select an element in the editing picture. 

 

Click this button and then click on the canvas to insert a new vertical and 
horizontal straight line into the picture. 

 
Click this button and then click on the canvas to place text on top of the picture. 

 
Click this button to arrange the vertical position of each element in the picture. 

 
To edit a picture, select an image in the media library and click the [Editor] button. The editor is opened with 

the selected image being background with the width and height of the selected image. 
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Figure 65. Editor screen with selected image 

If you click the [Editor] button without selecting an image, a default canvas is display with 400x300 pixels by 

default.  
 

 
Figure 66. Editor screen without selected image 

In this case, you would be able to select a color as a background color by clicking the [Background Color] 

button. 

The canvas’s size can be edited by entering the Width, Height by pixel or dragging the bullet at the corners 
of the picture. The Constrain check box is used to lock the aspect ratio. 
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Click Image menu/Insert Image to add another image on the image you already added.  Then select Image 
menu/Scale Image to scale picture. 

 

 

 
Figure 67. Insert another image to selected image 

Editing text 

Click the  button and then click on the canvas to place a text box on the canvas. 

 
Figure 68. Editing toolbar  

Double click on the text box area to enter the text and then using the toolbar to format the text or edit the 
width/height/location of the text box. 

 
Figure 69. Text box in Editor 
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Editing lines 

Click the [Line Tool] button ( ) and then click on the canvas to insert a new horizontal line into the picture. 

 
Figure 70. Editing toolbar  

 
 
Use tools on the Toolbar to adjust the color and 
stroke of the lines. You can also change its 
thickness, length and position. 
 

 

 

Layers 

Click the [Layers] button  to open the Layers 

window and use the up/down arrow  to 
arrange the vertical position of each element in 
the picture.  

 
 

Saving image 
After finish editing you might save the picture by click File menu/Save or you can save it as another item. The 

Ariadne Editor allows you to save the image in three types: 

 BMP file 

 PNG file 

 JPG file  

 EDITOR file: This file type is the special type which save all the items (e.g.: text box) you have added 
to the image so that user can edit these items later on. Saving the images in .editor files is a wonderful 
feature of the system. It combines many kinds of Imagery objects in the same canvas. 



 

CHAPTER 2 

Using Ariadne 61 
 

 

Preview 
As you know, Ariadne users can manage signs from anywhere with network contact to the Ariadne server. To 
facilitate this, Ariadne provides the Preview feature which can enable users to see what is displayed on a given 
sign on a specific time. This feature can be launched by the [Preview] button on View Pane: 

 
Figure 71. Preview button 

The content of Preview window is based on the date selected by user in the IUI. 

 
Figure 72. Select date 

Preview Window 
After selecting date and pressing [Preview] button, the Preview window is displayed: 

 
Figure 73. Preview window 

The window consists of 2 areas: Menu area (on the left) and Display area (on the right). When user operates 
on the Menu area, the content corresponding to his configuration will be shown on Display area.  
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Button Action 

Refresh Reload the content of the selected sign 

Close Close the Preview window 

 

Select Sign 

 

In this section, user can select a sign from the 
dropdown list to see what is displayed on that sign 
at a specific time. 

NOTE: After selecting another sign, user has to 

press [Refresh] button to load content displayed on 

the selected sign. 
 

View Type 

 

In this section, user can select a view mode for the 
displayed content. 

Live view: This option is only available if selected 
date is current date. If user selects this option, he 
can see what is being displayed for the selected 
sign. When Live view is on, Layer and Time 
Selection will be disabled. 

Specific layer and time: This option being selected 
means that Layer Selection is enabled. With this 
option, user can combine with choice he makes in 
Layer Selection and Time Selection to preview. 

 

Layer Selection 

 

In this section, user can select layers to be shown 
on Display area for the selected sign. It is only 
enabled if Specific layer and time View Type is 
selected. 

If Preview only selected layer option is checked: 
Only selected layer is displayed. 

If Preview only selected layer option is 

unchecked: The selected layer and all layers with 
lower level are displayed. 

E.g.: If user selects layer 3 (Meeting, Message, 
Guest) and uncheck Preview only selected layer 
option, then layer 1 (Background Image), layer 2 
(Background Object) and layer 3 are displayed. 

For more details about this rule, please see Layer 
section in Chapter 1 of this document. 
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Media Information 

 

In this section, user can view the information of the 
media when he clicks the object on Display area. If 
the Media Type is Image, the width and height 
information are physical size of media. Otherwise 
they are blank. 

 

 

Time selection 
This section is only available if user selects Specific layer and time view type. 

In this section, there is a timeline which clearly indicates when content changes, and allows the user to directly 
click a certain timeslot in the timeline to see what the sign looks like at that time: 
 

 

Recurring (End By, never ending) 
Recurring is a function allowing an event to happen repeatedly in a specific time range. This function also 
manages how many times the event recurs. 

When a user creates an event, there are 3 recurring 

options: 

 None 

 Daily 

 Weekly 

If user selects None for Recurring value, the event 

only takes place one time in the specified day. And 
when the event is updated or deleted, it takes effect on 

single events. 

If the Recurring value is not None, the following fields 

appear: 

 Recur every:  the period of time between each 

event in the series. 

 End After: number of times the event recurs. 

(Similar to the End after value in Microsoft 
Outlook). In the Background and Message 
tabs, user has option to choose the End After 
value as Never indicating that the created 

background recurs endlessly. 
 End By: the end date of a recurring event.  This 

field has very close ties to the start date, the 
period of time between each event in the series 

and the number of times the event recurs.  

User can choose either the End After or End By to end 

a recurring event. 
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 Optional area: This area only becomes 
visible if event recur weekly to specify 
weekdays that the event will recur.  

 The number of event created is the End after 

value.  

 

 

Delete a recurring event 

It’s possible to delete a specific event in the series of events or delete all events in the series.  

To delete a single event, select that event on the Timeline, open the menu from the Ariadne icon and choose 
Delete. 

 
Figure 74. Delete single event in the series 

To delete all events of a recurring event, select the recurring event name in the View Menu Pane, open the 
menu from the Ariadne icon and choose Delete series. 

 
Figure 75. Delete series 

NOTE: If the event series has resource conflict with an existing single event in the system then the event 

series will have higher priority that means the event series would be display on screen. When the series is 
deleted or updated removing resource conflict, then the single event will be display on screen. 
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